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CHAPTER 1 Overview
MobileView Navigator is a Windows application used to view video, export evidence files, maintain 
recorders and interact with the MobileView recording system in real time. The software is considered 
a media player and maintenance utility. This video software enables security-related personnel to 
easily and remotely gather video evidence, monitor live situations, and configure and maintain a 
mobile video surveillance system. MobileView Navigator provides an intuitive way to find and 
provide relevant video content. The player is easily accessed when choosing to view video from 
Depot Manager and is installed on the local hard drive. It can be installed in Windows Enterprise or 
stand alone environments.

Client and Standalone Connection 
MobileView Navigator has two different modes of operation, client mode or standalone mode. These 
modes are automatically selected by the software when it is started. 

Client Mode 
The client mode is automatically selected when a video or connection to a recorder is launched by 
Depot Manager. Clicking on a video link within Depot Manager starts MobileView Navigator in this 
mode. While in client mode, Navigator cannot discover or communicate with other recorders on the 
network. It relies solely on Depot Manager to tell it how to operate.

Standalone Mode 
The standalone mode is automatically selected when MobileView Navigator is opened directly. This 
mode is used to view files on the computer by technicians in the field, and when a caddy is needed. In 
standalone mode the software is independent of the server, it can discover other vehicles, and has a 
small database where user accounts and vehicle information is stored.

MobileView Navigator is fully integrated with Depot Manager and runs in Standalone mode. 
Standalone mode is used when there is not a connection to the Depot Server. Changes made during 
Standalone mode are specific to a specified depot and are performed independently of the Depot 
Server. 
MobileView Navigator 2.0 User Guide 7
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The connection of Standalone mode to Connect mode is automatic. The current mode is displayed in 
the MobileView Navigator window.

Log in to MobileView Navigator
After a successful installation, launch MobileView Navigator using one of the following methods:

– Double-click on the MobileView Navigator icon on the desktop.
– Access the Start menu. Select All Programs, Interlogix, MobileView Navigator.

When MobileView Navigator launches, a login window displays. Log in as the default Administrator 
using the following default credentials:

– User-name - admin
– Password - admin 

If a non administrator logs in for the first time they are forced to change the default password. If the 
password is forgotten, click Forgot on the Login window and answer the challenge question.

MobileView Navigator Window
The following is an overview of the MobileView Navigator main window.
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MobileView Navigator Window
MobileView Navigator consists of several panels. Panels are resized by dragging the vertical left or 
right splitter bars. An arrow next to panel names signifies the ability to hide or show the panel. This 
provides custom application layout styles depending on the activities performed. 

Main Window Items

Item Name Description

1 File Menu Contains file, tools, and help commands.

2 Toolbar Contains shortcuts to common operations 

3 Vehicle Selector 
Panel

All of the folders and respective devices in folders are loaded 
into the Vehicle Selector tree. The state of devices loaded is 
represented on the tree. (Reachable/Not reachable)
If any caddies are discovered they are added under Docking 
Stations node.

4 Disk Analysis When a video tile is selected, the disk analysis for that 
camera is displayed under the timeline bar.

5 Timeline Bar While playing video, all cameras play in sync. The video time 
displayed on the viewer and the time line pointer moves as 
the video proceeds.

6 Video Display Displays live or playback video

7 Video Layout 
Manager

Contains commands related to the Video layout: Stream 
modes, display modes, overlay, maximize/restore, and 
close.

8 Help Launches the user manual.
MobileView Navigator 2.0 User Guide 9
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File Menu
Use the File pull down menu for file, tools, and help. Use the Choose a video file to open. To save a 
video file, use Save As or burn the file to a media device. Clicking Exit closes the MobileView 
Navigator software.

Use the Tools pull down menu to access the address book, manage users, change passwords, preserve 
video aspect ratio, update the offline GPS map, or to set MobileView Navigator settings. System 
settings and server settings are set using the Settings option. Identify the system for discovery using 
the Discovery tab. 

Access the Help pull down to open the MobileView Navigator help and also to view the current 
version of the MobileView Navigator software that is running.

Timeline Bar
Video is managed once it is loaded in the Video Display panel on the Timeline toolbar. The Timeline 
toolbar features a toolbar, timeline, playback controls, and stream switching capabilities. 

Use the toolbar to select all video tiles in the viewer, zoom in and out on the timeline, center the 
timeline, perform a Go To search, and view video in live or playback mode. Use the Snapshot option 
to take a snapshot of the current play time of a selected video tile and save it to the hard drive to 
export. 

Timeline and video controls are only enabled while viewing video.

Item Name Description

1 Zoom In Expands the disk analysis at a detailed view.

2 Zoom Out Opens the disk analysis at a general or smaller view.

3 Center Timeline Centers the timeline pointer of the currently playing video to 
the center of the timeline.

4 Range Reset Resets the selected video range on the timeline bar.

5 Playback/Live Toggle Toggles from Play Live to Play Playback. When Live video is 
playing the icon displays Live.

6 Go To Opens a window to choose a specific date and time of video. 
Video pulls from the device for the selected date and time.

7 Loop Video Plays video between the selected range of time in a loop. 
When looping the video, a red indicator displays in the 
center of the icon. Click the looping icon to exit looping 
video.

8 Audio Controls Audio Channel Selector, Camera Audio Selector, and Video 
Audio Selector. Select audio on or off. 
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MobileView Navigator Window
Application Toolbar
The available options on the application Toolbar vary depending upon the user login.

question, and change the password. 

9 Video Playback 
Controls

 Contains commands related to the video control. Refer to 
the Video Playback Controls section.

10 Snapshot Takes a screen snap of the currently playing video stream.

11 Export Video Clip Opens a window to select cameras. Video for all the 
selected cameras is exported into a single file (multiplexed 
video).

12 Image Log Opens the Image Log window. Select an exported video file 
from the device or docking station.

13 Show Map A map displays when playing live or playback video. Use to 
track a vehicle on the map. The map control window opens 
with the map displayed at zoom level 8 on the given route. 
There are 16 zoom levels.

14 Local File Information Views the local file information at any time while video is 
playing.

15 Stream Choose the type of stream to use, primary or alternate.

Item Name Description

1 Open video file Browse to the desired video file and select the file to open.

2 Burn Video 
File to Media

Launches the CD/DVD burner or USB window with options 
to select files for burning to a CD / DVD or to write to USB.

3 Address Book Opens the address book of Vehicles. Use to add or remove 
vehicles and also import and export vehicle lists.

4 User 
management

Opens a list of users. Double clicking a user name opens the 
User Properties window.

5 Password 
Management

Launches Password Management windows.

Item Name Description
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Video Layout Manager
The Video Layout Manager controls how the videos are displayed in MobileView Navigator.

Playback Controls
The Playback Control buttons control how the video is displayed. 

Item Name Description

1 Paging Open multiple pages of video tiles.

2 Video Layout Changes the tile display of the videos.

3 Camera 
Display Order

Changes the camera display order.

4 Overlay Displays the Vehicle ID and the time in milliseconds. 

5 Maximize 
Restore layout

Maximizes the current layout. The current layout is 
maximized to full screen mode. 

6 Close Closes all of the videos streaming in the current layout tiles.

Item Name Description

1 Step Reverse View the next frame in reverse direction.

2 Play Reverse Plays current video in reverse mode at normal speed. 
Clicking the icon again, the speed is increased. The speed 
management is device dependent.

3 Pause/Play Pauses the video or plays the selected video at normal 
speed.

4 Fast Forward Plays current video in forward direction. Clicking the icon 
again, the speed is increased. The speed management is 
device dependent.

5 Step Forward View the next frame in forward direction.
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CHAPTER 2 Basic Functions
Manage Users
In standalone mode, Administrator users can use the User Management Toolbar to add or modify a 
user. 

Add User
1. Click Tools.
2. Click User Management.
3. Click the green plus sign, the Add User icon.

4. The Admin enters the necessary information to create a new user.
A window displays stating the user was added successfully. A system generated password is e-mailed 
to the email-id provided. When prompted for the first time, create a unique password. 
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Update User Information
The Admin user can update user information including first name, last name, email, and phone 
number. 

1. Click the Tools menu.
2. Click User Management.
3. Click on Admin.
4. After updates have been made, click Update to save the new information.

User Permissions
The MobileView Navigator window displays based on user permissions. The vehicle selector tree 
populates with folders and devices from the database. Each device in the tree is highlighted according 
to the availability status. Devices not available display in italic font. 

A normal user can perform all of the operations available in the application except managing users, 
task scheduling, and managing system settings.

Application Permissions: Admin User
An Administrator can set the following permissions:

• Manage vehicle list
• Task scheduling
• Manage users
• Password management
• Local file playback
• Settings
• Burn video file to media
• Services
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Viewing Connected Work Stations
• Erase disk

Application Permissions: Normal User
A normal user can set the following permissions:

• Manage vehicle list
• Password management
• Local file playback
• Burn video file to media

Manage Password
Each user has a unique password that is set up when the user is created. Only the Administrator can 
change the password, challenge question, and answer.

1. Click the Password Management icon.
2. Change the user password by entering the old password followed by the new password. 
3. Change the security question and answer. 

Viewing Connected Work Stations
All connected workstations can be viewed by clicking the plus sign in front of the Work Stations 
option. Video files can be opened and closed (released) through the Work Station option. Click the 
Work Station name and right click to Open File or Release Files.

Using Video

Open a Video File
The Video Display panel allows both live and recorded video from any video source in the system. It 
contains live or previously recorded video launched from the search, vehicle selector, or disk analysis 
panels. 

Open a Local Video File
To open previously saved video files:

1. Click the File menu and click Open Video File. 
2. Use the Open Video File menu to select a video file from local disk or network. 
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3. Select the video file name and click Open. MobileView Navigator plays the video file. 

Note: An alternate way to open a video files is to click the movie icon on the toolbar.

Open Live Video
1. Click the Vehicle folder.
2. Select the desired device and right click to open the menu.
3. Click Open Live to view live videos of a device in reachable state.

Open a Playback Video
1. Click the Vehicle folder.
2. Select the desired device and right click to open the menu.
3. Click Open Playback to view playback videos on a device.
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Using Video
4. Click Playback to view the last 15 Minutes or 30 Minutes.

View Video Information
Displays the header and footer data for the selected video tile. The following information is displayed 
on the header and footer of the video tile: 

• Camera title 
• Video play time
• Device name
• Video stream state
• Close video tile

Identify Live or Playback Mode
When a video is open, the top of the viewer caption bar displays the current activity Live or Playback. 

The corner of each video displays whether the video is Live or Playback.

View Video Tiles
There are several tile layouts to choose from when arranging the videos. Change the layout by 
clicking the layout icon. 

Use Layout Selector to change the video tile layout. Layout selector shows all available layouts. 
MobileView Navigator displays only those cameras associated with the device. All other cameras 
close.
MobileView Navigator 2.0 User Guide 19



Basic Functions

20
Standard tile layouts include 1×1, 2×2, 3×3, 4×4, and 5×5. Custom tile layout is also supported with 1 
large tile and 7 smaller surrounding tiles. Double-clicking in any single tile brings video to a full 
screen. Double-clicking the tile again restores the video to the previous tile layout size. 

Opening and closing of an individual camera stream is supported in the application. When a new 
layout is selected, all existing video streams and controls change to the new layout. Layout is 
supported for live, playback and local file playback. Changing a layout from a larger number of views 
to a smaller results in a confirmation asking to close cameras. Once the cameras are closed, they do 
not display in the window.

Adjust Camera Order
Select the order cameras will display in the window. 

1. Click the Camera Order icon.

2. Adjust the order of cameras by selecting a camera and using the up and down arrows to move its 
position in the display window.

3. Click OK.

Video Overlay
Click Overlay on the Video Layout Manager Toolbar to enable or disable overlay. Overlay displays 
the Vehicle ID and the time in milliseconds. Overlay is turned on when the check mark displays. 

Maximize Video
1. Click the Maximize/Restore icon. The window expands and the left side menu no longer 

displays. 
2. Place your cursor in the top right section of the window until the Video Manager toolbar 

displays. 
3. Click the Maximize/Restore icon again to restore the window to the original view to include the 

left side menu.
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Using Video
Close All Video Tiles
Click the X icon to close all videos.

Find the Time Zone
The top of the viewer caption bar displays the MobileView Navigator time zone.

Maximize Video
When viewing a video, double click on the individual video tile to zoom in. The video fills all tiles. 
To zoom out, double click again, the video resumes the regular viewing size.

Search Video
Searching for video can be performed in a variety of ways.

Search by Date and Time (Live mode only)
1. Click Go To from the timeline. 
2. Select the desired Date/Time. 
3. Click OK to start the search. 
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Select Video Using Timeline Bar
Using the mouse, hover over the Timeline Bar. When the range selection indicators appear, move 
(slide) the selection start time indicator and the selection end time indicator to select the time range. 

Double-clicking anywhere on the timeline automatically plays back the selected video at the specific 
date and time. Use the current live or playback cursor (a blue seek triangle icon) to seek and play the 
video anywhere along the timeline. 

1. Click to magnify the time frame. This is located on the far left of the timeline.
2. Click to reduce the time frame. 

Docking Stations and Caddies
MobileView Navigator automatically searches for hard drives added to the computer or network and 
updates the vehicle selector by adding newly found caddies or compatible Docking Stations. If a 
caddy is removed from the computer after it is discovered, the caddy disappears from the Docking 
Stations list.

Once a caddy is added to the tree, the following options can be performed:

• Play video from disk beginning.
• Goto option on timeline bar displays video from any date and time.
• Use timeline controls to perform video operations including fast forward, fast reverse, frame next 

and previous frame.
• Click Map in the toolbar to view the vehicle moving on the map.
The disk analysis for selected cameras are displayed on the timeline bar.

Access log files on the caddy by clicking Get HDD Log from the Caddy menu. Select a timeline 
within the range of videos recorded. Choose within From and To times of the recorded video.
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Display Events
Display Events
When a vehicle is configured to record or mark events, an indicator displays on the timeline for 
events occurred. There are several reasons an event would occur:

• Door open
• Turn signal
• Headlights
• Wheelchair ramp
• Emergency tag
• Silent alarm
Event types are represented by different colors. Events display on the timeline in red to indicate an 
event has occurred. Green lines indicate video was recorded. 
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Events are also displayed in the Disk Analysis. 

Device Menu
To open the Device menu:

1. In the Vehicles folder, locate the desired device.
2. Click the device.
3. Right click to open the Device menu.

Use the Device menu to perform any of the following options:

• Run health diagnostics
• Disk analysis
• Search

Definition of events

Color Event Type

Gray Untagged

Blue Video Loss

Red Alarm

Green Normal Video

Yellow Other event
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Device Menu
• Open live
• Open playback
• Close
• Upload configuration file
• Download configuration file
• Upload firmware
• Configure device
• Get Log File
• Reboot service
• Delete
• Properties

Disk Analysis
Disk Analysis is retrieved and displays the recorded data in graphic format. The window displays the 
video data available on the disk. It displays the video type (Alarm, Video Loss, and No Video) for 
each camera using color coding. Refresh to retrieve the latest disk analysis. Some disk analysis may 
take time to analyze the data.

1. Click the Vehicle folder.
2. Select the desired device and right click to open the menu.
3. Click Disk Analysis.
4. The device cameras display with a graphic display of each camera video. Explanation of the 

color codes are located at the top of the window.
5. Zoom in on specific times to view a more detailed display of the camera status at a more specific 

time. Zoom by using the Zoom icons at the top left of the window.
6. By double clicking on a specific time area, the recorded video displays.
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Maps
MobileView Navigator can visually track a vehicle on a map. The location and the speed of the 
vehicle displays on the GPS map. The position of the vehicle is identified using coordinates within 
the video files. 

Note: Vehicle tracking on maps is only available on Live/Playback video in normal speed.

Track a Vehicle on a Map
When video is playing live or in playback mode, click on a map to control tracking of the vehicle on 
the map. The map control window opens with the map displayed at zoom level eight on the given 
route. There are 16 zoom levels.

The Vehicle tracks using a bus icon and video plays. The icon moves along the route with a tracking 
line where the vehicle has traveled. Panning can be performed on a map in all directions available in 
the selected zoom level.

1. Click on a video.
2. Click the highway sign on the toolbar to open the map. 

The map for the selected vehicle displays.

3. Locate the vehicle using the bus icon.
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Help
Help
If assistance is needed, click the Help menu and click Help Topic to receive help information. 

Exit
To exit from MobileView Navigator, click File and click Exit. 
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CHAPTER 3 Navigator Operations
Vehicles
After logging into the MobileView Navigator software, all connected vehicle names display. In 
standalone mode, MobileView Navigator checks the folder and the device list in the local database 
and uses the list to load vehicle names. All of the folders and respective devices in folders are loaded 
into the Vehicle Selector tree. The device state is represented on the tree. (reachable/not reachable) 
Unreachable device names display in italic font and reachable device names display in normal font. In 
client mode, the local database will not be displayed and any added vehicles to this list will not 
display. 

The Vehicle Selector panel features double-click, or drag and drop capability to view cameras or 
devices. Right-clicking on any object in the Vehicle Selector panel opens a menu of options that can 
be performed on the vehicle. The options include health diagnostics, device configuration, disk 
analysis, properties, search, firmware uploads, and more. This panel is permission based and not all 
options are available for all users.

If a caddy is discovered, the name is added to the Docking Stations folder. If any new devices are 
discovered they are added in New Vehicles.
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Upload Firmware
1. Click Upload Firmware from the Device menu. A window displays to browse the firmware for 

the device (.bin).
2. Select the appropriate firmware and upload to the device.

Get Hard Drive Log
The HDD log is the log file for the hard drive. Click Get HDD Log from the by right clicking on a 
device, save the log file in.HDDlog format.

Get Log File
Click Get Log File from right clicking on a device to retrieve the system log file. Save the log file in 
system log format.

Reboot Device
Click Reboot Device from right clicking on a device. The device reboots.
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Provisioning
Provisioning
Provisioning software is supported on the following recorder models:

• MobileView 3000 Series Analog Video Recorders
• MobileView 7000 Series Network Video Recorders
Use the provisioning tool to manage large systems from MobileView Navigator. The provisioning 
tool opens communication with the device:

• Connect to a DVR or NVR.
• Assign the device name.
• Configure the wireless network.
• Upload firmware.

Import/Export Address Book
1. Click the Tools menu.
2. Click Address Book. 
3. In the Address Book window, select either Import List or Export List of an address book. 
4. Select a .csv or WaveReader file for import. MobileView Navigator loads the contents of the 

address book file, parses the contents, and populates the Vehicle Selector tree in a folder named 
with the current date and time. 

All imported devices or folders are added to the application database.

When exporting a local address book file, select where the exported file will be saved. All of the 
devices in the Vehicle Selector tree export to HDD Caddy. Information from the tree is not exported. 

The exported files are in .csv format. The name of the file includes the mobile software version when 
the file has been exported. The exported file includes the device and camera information.

Note: The address book does not contain any hard drive caddy information. The hard drives 
are not configured in the vehicle selector and are automatically populated when a caddy 
device is discovered.
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MobileView Navigator automatically attempts to connect reachable devices and updates the status in 
Vehicle Selector. 

When a new device is discovered, MobileView Navigator adds the device to the New Vehicles folder. 
The following choices are available when a new device is discovered:

– Ignore the device and not add
– Drag and drop the device to the vehicles folder. 
– Monitor and perform options available for the device.

The following states display for vehicles and new devices depending on their accessibility. 

– Device not reachable (grayed out and italicized)
– Connected/Reachable (normal font)

Cameras associated with the device are populated when moving the device from the New Device 
folder to the Vehicles folder. After populating, live and playback video for the device can be accessed.

New Devices

Auto Discovery
In standalone mode, MobileView Navigator automatically communicates with devices that are on the 
same network. New and updated vehicles are identified and added automatically to the vehicle list 
and display in the New Devices list automatically. 

Manually Add Vehicle
When a vehicle is not automatically added, perform a manual add. 

1. Right click the Vehicle folder and click Add Device. The Add Device window opens. 
2. Enter the Device Title and the Device ID.

3. Click OK. 

Note: The device is added in a disconnected state. Once the device is online, the device tree 
updates to display the device in the vehicle list. 
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New Devices
4. Drag any desired devices to the Vehicles folder. To select multiple vehicles, use the Ctrl key on 
the keyboard while selecting multiple vehicles. 

Vehicle Management
1. Open Vehicle Management and double-click on a row. 
2. Modify the details of the device.
3. Click the Add Vehicle toolbar on the Manage Vehicle List form. The Add new device window 

opens. The newly added device is updated in the vehicle selector list.
4. Select a device row in the Manage Vehicle List.
5. Click Remove Vehicle on the toolbar. The selected device in the grid deletes from the list.
6. Export the vehicle list to .csv format file by clicking Export List on the toolbar.
7. Import vehicles from address book (exported) files. Click Import List on the toolbar. 
An open file window appears, choose a .csv file (Mobile/Wave Reader) file. When a valid file is 
selected, the vehicles list is imported displaying in the vehicle management grid and is updated in the 
vehicle selector.

Search for Device in Vehicle Selector
1. Select Depot and right-click.
2. Click Search. This opens a search text box. 
3. Enter the name of the Device Folder and click Search. 

The scroll bar automatically scrolls to the item selected when the Vehicle list is displayed. The next 
device or folder meeting the search criteria can be reached by clicking search again. If the selection 
reaches the end of vehicle selector, all search results highlight.

Service Port When Device Not Added
When a device has not yet been added, the Service Port Option will display on available MobileView 
systems when directly connected to the front Ethernet port on the device. 

1. Select the system type to add a device. 
– MVIII
– MV 3004
– MV 3008
– MV 3012
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– MV 7001
2. Enter the IP Address and click OK.

Service Port When Device Added
Once a device is added, tasks can be run from the Service Port option. 

Right-click Service Port to perform one of the following tasks. 

• Run Health Diagnostics
• Disk Analysis
• Open Live
• Open Playback
• Close
• Upload Configuration File
• Download Configuration File
• Upload Firmware
• Configure Device
• Get HDD Log
• Reboot Device
• Properties
Details on how to perform any of the above tasks are located within this guide.

Device Tasks
Devices are digital video recorders.

Standalone Mode Settings
1. Open the Tools menu.
2. Click Settings.
3. Click either the System tab or the Discovery tab.
Use the Discovery tab to identify the default IP address and port number.

SMTP
The SMTP settings are used to configure the server to enable email notifications. 

The following SMTP Server (SMTP Server details) display on the System tab:

– Server name
– Port
– User name
– Password
– SSL
– Primary email address
– Secondary email address
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Device Tasks
– Test (to test the connection)

Device Diagnostics
1. Select a device.
2. Open the Device Menu.
3. Click Run Health Diagnostics.
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Device Properties
Click Properties from the Device menu. The device properties open in a tab format and display the 
device properties. Editing depot properties allow changes to be made to depot naming, connection 
information, and video repository information.

Edit Depot Properties
1. On the Depots menu, select the depot you wish to configure and select Edit from the drop-down 

list.
2. The Edit depot screen appears. Configure the depot.
3. Click Save.

Device Connection
MobileView Navigator allows only one device to be connected and accessed at a time. Choose any 
device in the tree. The application switches to the currently selected device.

The selected device title is displayed in the Vehicle Selector caption bar. Vehicles in the New vehicles 
folder are not accessible until they are moved to the Vehicles folder.
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Device Tasks
Select a Device. If the connection is successful, these updates are made to the main window:

– The connected device and all available cameras are populated and expanded.
– Timeline and video controls are in a disabled state. They are enabled only while viewing 

video.
– MobileView Navigator allows only one device or caddy to be connected at a time. When a 

new device is connected, the currently streamed videos close.
– Access any feature available on the device.
– The currently selected device title is displayed in the Vehicle Selector section.

Out of Network Device
When a device is out of network while performing operations, a status message displays indicating 
the device is out of network.

Vehicle Selector updates to indicate the device is not in reachable status. If Live or Playback videos 
are playing for a device, all of the tiles close and the layout is brought to the initial view. All objects 
related to the device state clear.

Details
Device details are displayed in the Details tab.
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Capabilities
Device capabilities are displayed in the Capabilities tab.
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Device Tasks
Device Configuration
MobileView Navigator remotely configures networked devices and manages linked and saved 
configurations. Device configurations are supported for one, multiple, all or none of the selected 
devices. Use this option to used to configure e-mail notification rules for when a bulk device 
configuration or firmware upgrade is either completed or failed.

1. Open Vehicle Selector.
2. Right click on the device.
3. Click Configure Device.
4. Edit or delete configuration information in the window.

Devices can be remotely upgraded on networked devices. The device status typically displays offline 
until it is assigned a configuration.

Download Configuration
Use Download Configuration to download the device’s configuration file to save or apply to another 
device.

1. Click Download Configuration from the Device Menu.
2. Select the Configuration file in ".cfg." file format.

Upload Configuration File
Use Upload Configuration to upload a saved configuration file.

1. Click Upload Configuration from the Device Menu. 
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2. Select the Configuration file in ".cfg." file format.
3. Click Upload.

Configuration Profile
The configuration profile contains all necessary data for the device configuration. Any information 
stored in the profile can be edited or deleted. Use the profile to link devices to profiles to manage 
devices easier.

Alarms 
Alarms are related to events that triggered on a device. To search for alarms on a device:

1. Right click on the desired device.
2. Click Search. 
3. Enter the credentials to search for alarms. and click Search.
4. Found alarms and details display in the window.

5. Click on the listed alarm and click Play Video. The video alarm displays.

Advanced Search
Click Advance Search from the Advanced tab. Device cameras are populated and display in the 
check box list. Alarm types with check boxes are dynamically displayed by capabilities of the 
currently selected device. 
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Advanced Search
The following search filters for alarms are supported.

– Alarm event
– Start time
– End time
– Cameras

1. Perform a search from the Search History or Search Device.
2. After selecting the filters, click Search. 
3. The results display in a grid below the search parameters area and separately in the Search result.
4. Click the right corner of search Results panel and click Show Details. The clear option clears the 

results found from search.

Search Results
In the Time column select a result to view video. The video displays in a panel starting from the 
displayed time. If playback video is currently playing, all of the cameras change to the new time. If 
the video is not playing, MobileView Navigator opens streams for all cameras at the time of the 
alarm.

1. Export video from the search results by right clicking any of the listed results and click Export 
Video.
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2. If auto download is enabled for the device, click in the Start Time column to download a clip 
(local file playback).

3. Click Show Details, a separate window displays details. 
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CHAPTER 4 Saving and Exporting Video Tasks
Synchronous Download
MobileView Navigator can download multiple video cameras containing a single file. The file can be 
copied using a single filename and saved. 

Video Stream
Video streaming is available in two download choices. Use primary or alternate video streams with 
downloads for events or evidence. Primary downloads are of higher quality but are larger in size 
while alternate stream is of low quality but is smaller in size.

The video download facility is available only in playback mode. The facility chooses either Primary 
or Alternate.

Video download facility is disabled when live streaming video.

Export Video
To download video, playback video in last 15 minutes, 30 minutes, or 1 hour, select the duration of 
the video to export. 

1. Click Video Export to save the video file.

2. Primary stream is the default. 
3. To change the stream, click Alternate Stream.
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A window displays requiring a check of disk space. Schedule the task to a scheduler service. If space 
is not available in the video repository, a warning message displays.

4. Select the appropriate option and click Start.

Open Video Clips
1. Click File.
2. Click Open Video Clip or select the video clip icon. 
3. Select the desired video clip and click Open.
4. Confirm the opening of the video.

Save a Video Clip from Downloaded Video
A small selection of a video can be saved as a video clip.

1. While the video displays, right click to open the menu.
2. Click Save Video.
3. Identify a name for the saved video. Browse to the directory where the file should save. 
4. Identify the begin and end time.
5. Click Start. The video file is saved. 

Export Snapshot
Use Snapshot to save the image of a single video tile of a playing video stream. 

1. Click Snapshot on the toolbar. The snapshot option is depicted by the camera icon. A window 
containing a list of all the cameras displays.
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Open Video Clips
2. Select the cameras containing video to be exported and click OK. The destination folder for the 
Snapshot files is written to the System Settings Snapshot folder. 

3. If another destination folder is desired, click Browse and choose a save directory.
4. Click Snapshot. A snapshot generates.

Note: If there is any delay in generating the snapshot, the snapshot option disables. It disables 
until the system completes generating the snapshot and when resumed becomes 
enabled. The result of generating the snapshot is a message displayed on the status bar. 

Save Video to Media
1. Click Burn Video File to Media to display a file window.
2. Select a file or files to be saved. 

Note: By default, the time length of the saved video is 15 minutes.

3. Click CD/DVD Writer tab to burn files to CD/DVD.
4. Click USB Writer tab to write files to USB.
5. Click Folder to write the files to a folder or a single executable file.
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6. Select the CD/DVD or USB drive from Disc Drives/USB Drives drop down menu.

7. Select to add files from a list box or click Remove to remove selected files.

Note: A mini player is also included with the file automatically. This allows any user to open 
and view the file without having MobileView Navigator loaded. The player saved can 
only play video.

8. Click Burn on the CD/DVD Writer tab and designate selected files to write on the CD/DVD. Use 
Write in USB Writer tab to write files to USB. Do not cancel the burn process. Do not close the 
Disc Burner window the middle of the writing process. If it is closed, a message displays stating 
“Busy with disc operation. Please wait.”

9. If needed, format the CD/DVD and erase the data on a rewritable CD/DVD by clicking Erase. 
All data on the CD/DVD is erased. Progress is shown for the operation on the Progress bar.

Save to Folder
Video evidence can be saved to a local or remote folder.

To include the player in a single file click Create Single File. This will create an .exe file that can be 
copied and used on another computer to play the video.

Save Video from Toolbar
1. Select a video to save. 
2. Click the Save Video Clip icon displayed as the movie reel icon on the toolbar.
3. Identify a name for the saved video. Browse to the directory where the file should save. 
4. Identify the begin and end time.
5. Click Start. The video file saves.

Create Evidence File
Evidence files are often used in court proceedings. Those who need the video are only interested in 
specific video. Saving video to a USB or CD/DVD creates an evidence file. A player is saved with the 
file for viewing the video.
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Creating an Image Log
1. On the bottom toolbar, click on the Image Log icon.
2. The Generate Image Log displays. 
3. Complete option selections and click Start.
The log is created for multiple images for the selected cameras during a specified time.
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CHAPTER 5 Windows Firewall
Administrative rights are needed to perform actions in this chapter. Contact your Network 
Administrator for additional help if needed.

Add a Port or Program 
Use the following to add a port or program when Windows Firewall is ON

1. Click System and Security and click Goto Control Panel.

2. Click Windows Firewall.
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3. Click Advanced Settings.

4. From Advanced Settings, click Inbound Rules and click on New Rule.

5. Select the type of firewall rule to create. A program or port can be selected. Click Next.
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Add a Port or Program
6. Specify the protocols and ports where the rules apply. (Ex: 1601 or input required port number).

7. Click Allow the connection.
MobileView Navigator 2.0 User Guide 51



Windows Firewall

52
8. Specify the profiles where the rules apply.

9. Specify the name and description of the rule and click Finish.
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Add a Port or Program
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